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Applicable in France Only 

A lire avant toute utilisation d'un jeu video par vous-meme ou votre 
enfant. Certaines personnes sont susceptibles de faire des crises 
d'epilepsie ou d'avoir des pertes de conscience 11. la vue de certains 
types de lumieres 
clignotantes ou d'elements frequents dans notre environment quotidien. 
Ces personnes s'exposent a des crises lorsqu 'elles regardent certaines 
images teJevisees ou qu'elles jouent a certains jeux video. Ces 
phenomenes peuvent apparaltre alors meme que Ie sujet n'a pas d'an­
tecedent medical ou n'a jamais ete confronte a une crise d'epilepsie. 

Si vous-meme ou un membre de votre famille avez deja presente 
des syrnptomes lies a l'epilepsie (crise ou perte de conscience) en 
presence de stimulations lumineuses, veui1lez consulter votre medecin 
avant toute utilisation. Nous conseillons aux parents d'etre attentifs a 
leurs enfants lorsqu'ils jouent avec des jeux video. Si vous-meme ou 
votre enfant presentez un des symptomes suivants: vertige, trouble de la 
vision, contraction des yeux ou des muscles, perte de conScience, trou­
ble de I'orientation, mouvement involontaire ou convulsion, veuillez 
immediatement cesser de jouer et consulter un medecin. 
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APPLICABLE IN FRANCE ONLY 
A lire avant toute utilisation d'un jeu video par vous-meme ou votre enfant. 
Certaines personnes sont susceptibles de faire des crises d'epilepsie ou d'avoir des 
pertes de conscience a la vue de certains types de lumieres clignotantes ou 
d'elements frequents dans notre environment quotidien. Ces personnes s'exposent a 
des crises lorsqu'elles regardent certaines images televisees ou qu 'elles jouent a 
certains jeux video. Ces phenomenes peuvent apparaitre alors meme que Ie sujet 
n'a pas d'anrecedent medical ou n'a jamais ere confronte a une crise d'epilepsie. 

Si vous-meme ou un membre de votre famille avez deja presenre des 
sympt6mes lies a l'epilepsie (crise ou pelte de conscience) en presence de 
stimulations lumineuses, veuillez consulter votre medecin avant toute utilisation. 
Nous conseillons aux parents d'etre attentifs a leurs enfants lorsqu'ils jouent avec 
des jeux video. Si vous-meme ou votre enfant presentez un des symptomes suivants: 
vertige, trouble de la vision, contraction des yeux ou des muscles, perte de 
conscience, trouble de l'orientation, mouvement involontaire ou convulsion, 
veuillez immediatement cesser de jouer et consulter un medecin. 

MINIMUM SYSTEM REQlJIREMENTS 
FOR WINDOWS® 95/3.1 AND MS-DOS® 
• 100% IBM PC-compatible computer 
• 386 processor 
• 640KRAM 
• CD-ROM drive (150Klsecond sustained transfer rate) 
• 40 MB of uncompressed hard disk space 
• VGAvideo 
• 100% Microsoft-compatible mouse and driver 

ADDITIONAL SYSTEM REQ!JIREMENTS 
FOR WINDOWS® 95 
• Microsoftl!!l Windows® 95 operating system 

ADDITIONAL SYSTEM REQ!JIREMENTS 
FOR WINDOWS® 3.1 
• Microsoft® Windows® 3.1 or 3.11 

ADD.ITIONAL SYSTEM REQ!JIREMENTS 
FORMS-DOS® 
• Microsoft® MS-DOS® 5.0 or higher operating system 



INSTALLING INFOCOM 
MASTERPIECES FOR WINDOWS® 95 
Installation of hifocom Mastelpieces is a two step process: 1) installation of the Infocom 
games and 2) installation of Adobe Acrobat Reader. 

BEFORE INSTALLING 
• Close all other applications 

• We do not recommend installing this program to a compressed drive. If possible, 
install to a non-compressed drive. 

HOW TO INSTALL 
l. Insert the Infocom Masterpieces CD disc in the CD-ROM drive. 

2. Select the Start button from the menu bar. 

3. Click on Run. When the dialog box appears, click the Browse button. Use 
Look in: to find the CD-ROM drive with the Masterpieces CD disc. 

4. Double-click on the Masterpieces CD disc icon. 

5. Double-click on the Winsetup icon. 

6. Follow the on-screen instructions. Once the Infocom installer is finished it will 
automatically launch the Adobe Acrobat installer. 

7. Read the licensing agreement for Adobe Acrobat and click on Accept. 
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8. Follow the on screen instructions. 

9. When installation is done, close both the Adobe Acrobat window and the Infocom 
window. 

The Infocom text adventures and the wim1ers of the Interactive Fiction contest have 
now been installed on your hard drive. 

WINDOWS 95 TROUBLESHOOTING 

PROBLEM 

Installation 
cannot be 
completed. 

Installer runs 
out of disk 
space. 

SOLUTION 

Hard drive contains too many programs and does not have enough room 
for The lnfocom Masterpieces. Back up any infrequently used programs, 
then delete them from the hard drive you are attempting to install to and 
try again. 

You are trying to install onto a compressed drive. Disk compression utilities 
cannot predict exact disk space; they can only estimate. The Infocom 
Masterpieces files may not compress as much as your disk compressor 
expects. Try installing into the uncompressed section of the drive. 
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HOW TO PLAY IN WINDOWS 95 

READING MANUALS, MAPS AND HINTS 
1. Select the Start button from the menu bar. 

2.. Under the Programs icon, select the Adobe Acrobat group, and then select 
Acrobat Reader 2.1. 

3. After Acrobat Reader launches, you will be prompted to open a file. 

4. Select your CD-ROM drive from the drives menu in the right comer. 

S. Select the Docs folder. 

6. Double click on the Infocom icon. 

7. For help using Adobe Acrobat, pull down the Help menu and select Acrobat 
Reader Help. 

Please note: You cannot play the In/ocom Masterpieces from the Adobe Acrobat 
program. To play the In/ocom Maste/pieces, follow the instructions below. 

PLAYING INFOCOM TEXT ADVENTURES 
1. Select the Start button from the menu bar. 

2. Click on Run. When the dialog box appears, click the Browse button. Use 
Look in: to find the directory where the In/ocom Maste/pieces was installed on 
the hard drive. If you used the default directory, the games were installed into the 
directory C:\INFOCOM. 
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3. Now select the folder of the game that you would like to play. For example, to play 
A Mind Forever Voyaging, double-click on the AMFV folder. 

4. When the AMFV folder opens, double-click on the AMFV file to play. 

5. The game will automatically launch. 

PLAYING THE WINNERS OF THE 
INTERACTIVE FlCTION CONTEST 
1. Select the Start button from the menu bar. 

2. Click on Run. When the dialog box appears, click the Browse button. Use 
Look in: to find the directOlY where the hifocom Mastelpieces was installed on 
the hard drive. If you used the default directoll', the ganles were installed into the 
directOlY C:\INFOCOM. 

3. Select the Winners folder. 

4. Select the game that you would like play and double-click on its icon. For example, 
to play 77Je Magic To),sbop, double-click on the MAGIC program icon. 

5. For additional help with playing the winners of the Interactive Fiction Contest, see 
the README file located on the Masterpieces CD disc. 
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INSTALLING INFOCOM 
MASTERPIECES FOR WINDOWS 3.1 
Installation of In/ocom Mastmpieces is a two step process: 1) installation of the 
Infocom games and 2) installation of Adobe Acrobat Reader. 

BEFORE INSTALLING 
• Close all other applications. 

• We do not recommend installing this program to a compressed drive. If possible, 
install to a non-compressed drive. 

HOW TO INSTALL 
l. Open Microsoft Windows 3.1. 

2. Insert the Infocom Masterpieces CD disc in the CD-ROM drive. 

3. Pull down the File menu in the Program Manager and select Run ... 

4. Click on the Browse button. 

5. Select the drive where you inserted your Infocom Masterpieces CD disc. 

6. Double-click on the Winsetup icon. 

7. Follow the on screen instructions. Once the Infocom installer is finished it will 
automatically launch the Adobe Acrobat installer. 

8. Read the licensing agreement for Adobe Acrobat and click on Accept. 
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9. Follow the on screen instmctions. 

10. When installation is done, close both the Adobe Acrobat window and the Infocom 
window. 

The Infocom text adventures and the winners of the Interactive Fiction contest have 
now been installed on your hard drive. 

WINDOWS 3.1 TROUBLESHOOTING 
PROBLEM 

Installation 
cannot be 
completed. 

Installer runs 
out of disk 
space. 

In Windows, 
The Infocom 
Masterpieces 
program group 
and icons do 
not appear. 

SOLUTION 

Hard drive contains too many programs and does not have enough room 
for The Infocom Masterpieces. Back up any infrequently used programs 
then delete them from the hard disk drive you are attempting to install to 
and try again. 

You are trying to install onto a compressed drive. Disk compression utilities 
cannot predict exact disk space; they can only estimate. The Infocom 
Masterpieces files may not compress as much 'as your disk compressor· 
expects. Try installing into the uncompressed section of the drive. 

Windows is running under a shell program other than Program Manager. 
Other shell programs other than the Windows Program Manager are not 
supported. Make sure that in you System.ini file in the Windows directory, 
the shell command reads "Shell-Program.exe." 
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HOW TO PLAY IN WINDOWS 3.1 

READING MANUALS, MAPS AND HINTS 
l. Select the Adobe Acrobat group icon. 

2. Select Acrobat Reader 2.1. 

3. After Acrobat Reader launches, you will be prompted to open a file. 

4. First, select your CD-ROM drive from the drives menu in the right corner. 

5. Select the Docs folder. 

6. Double click on the lnfocom.pdf file. 

1. For help using Adobe Acrobat, pull down the Help menu and select Acrobat 
Reader Help. 

Please note: You cannot play the Infocom Mastelpieces from the Adobe Acrobat 
program. To play the Infocom MasteJpieces, follow the instructions below. 

PLAYING INFOCOM TEXT ADVENTURES 
l. Pull down the File menu in the Program Manager and select Run ... 

2. Click on the Browse button. 

3. Select your hard drive and then select the folder where Infocom Mastelpieces is 
installed. If you used the default direct01l', the games were installed into the 
direct01l' C:\INFOCOM. 
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4. Now select the folder of the game that you would like to play. For example, to play 
A Mind Forever Voyaging, double-click on the AMFV folder. 

5. When the AMFV folder opens, double-click on the AMFV.bat file to play. 

6. The game will automatically launch. 

PLAYING THE WINNERS OF THE 
INTERACTIVE FICTION CONTEST 
l. Pull down the File menu in the Program Manager and select Run .. . 

2. Click on the Browse button. 

3. Select your hard drive and then select the folder where Infocom MasteJpieces is 
installed. If you used the default direct01l', the games were installed into the 
directory C:\INFOCOM 

4. Select the Winners folder. 

5. Select the game that you would like play and double-click on its icon. For example, 
to play 77Je Magic Toysbop, double-click on the MAGIC.exe (please note some 
files have .bat extensions and some .exe extensions) program icon. 

6. For additional help with playing the winners of the Interactive Fiction Contest, see 
the README file located on the Masterpieces CD disc. 
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INSTALLING INFOCOM 
MASTERPIECES FORMS-DOS 
Installation of In/ocom Masterpieces is a two step process: 1) installation of the 
Infocom games and 2) installation of Adobe Acrobat Reader. 

BEFORE INSTALLING 
Here is some important information that you should know before you install and start 
playing In/ocom Masterpieces/or MS-DOS. 

HARD DISK 
The game requires at least 40 ME of uncompressed free hard disk space. In/ocom 
Masterpieces will not work properly using compressed hard disk space (such as Stacker 
and DoubleSpace). 

HOW TO INSTALL 
1. Insert Infocom Masterpieces into your CD-ROM drive (for these instructions, 

we will assume that your CD drive is drive D:). 

2. At the DOS prompt, type D: and press Enter. 

3. At the D:\ > prompt, type DOSSETUP and press Enter. 

4. Follow the on-screen instructions carefully. 
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MS-DOS TROUBLESHOOTING 

MEMORY 
In/ocom Masterpieces requires a minimum of 640K of system memory (RAM). On 
some machines, even if you have the required 6401\, In/ocom Masterpieces may report 
that you do not have enough free extended or conventional memOly. 

You might try disabling SMARTDRV, changing your CONFIG.SYS and 
AUTO EXEC. BAT so that some of your drivers are loaded into conventional rather than 
high memory or setting your EMM386 line to NOEMS. 

Since these modifications affect your CONFIG.SYS and AUTOEXEC.BAT files, you 
should consider making these changes to CONFIG.SYS and AUTOEXEC.BAT files on a 
boot disk. 

HOW TO PLAY IN MS-DOS 

READING MANUALS , MAPS AND HINTS 
1. Select the directory where you installed Adobe Acrobat Reader for DOS. The default 

directory is C:\ACRODOS. 

2. Type ACROBAT.EXE and press Enter to launch Adobe Acrobat Reader for DOS. 

3. After Acrobat Reader launches, you will be prompted to open a file. 

4. First, select your CD-ROM drive from the drives menu in the right comer. 

11 MS-DOS 



S. Select the Docs folder. 

6. Double click on the Infocom.pdffile. 

7. For help using Adobe Acrobat, pull down the Help menu and select Acrobat 
Reader Help. 

Please note: You cannot play the hifocom Mastelpieces from the Adobe Acrobat 
program. To play the hifocom Mastelpieces, follow the instructions below. 

PLAYING INFOCOM TEXT ADVENTURES 
1. Select the directOlY where you installed hifocom Mastelpieces. The default directOlY 

is C:\INFOCOM. 

2. Change to the directory of the game you want to play. For exanlple, to play A Mind 
Forever Voyaging, type CD AMFV and press Enter. 

3. Type the name of the game you want to play and press Enter. For example, to play 
A Mind Forever Voyaging, type AMFV.bat, and the game will launch 
automatically. 
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PLAYING THE WINNERS OF THE 
INTERACTIVE FICTION CONTEST 
1. Select the directOlY where you installed hifocom Mastelpieces. The default directory 

is C:\INFOCOM. 

2. Change to the WINNERS directory by typing CD WINNERS and press Enter. 

3. Select the game that you would like to play, type its name and press Enter. For 
example, to play J7Je Magic Toysbop, type MAGIC.EXE and press Enter. 

4. For additional help with playing the winners of tlle Interactive Fiction Contest, see 
the README file located on the Masterpieces CD disc. 
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MINIMUM SYSTEM REQ!JIREMENTS 
FOR MACINTOSH 

• Macintosh or 100% compatible 
• Mac Plus or higher 
· 4MBRAM 
• CD-ROM drive (150Klsecond sustained transfer rate) 
• 5 MB of uncompressed hard disk space (in addition to any needed 

for virtual memory) 
• System 6.0.7 or higher 

INSTALLING INFOCOM 
MASTERPIECES FORMACINTOSH 

HOW TO INSTALL 
1. Before installing, close all other applications and make sure you've disabled all 

unnecessaJY system extensions (e.g., virus detection software). The Simplest way to 
do this is to open the Extensions Manager in the Control Panel and un-check 
all unnecessruy extensions that you may be running. Then restart your computer. 
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2. Insert Infocom Masterpieces CD disc into your CD-ROM drive and wait a few 
moments until the Masterpieces CD-ROM icon appears. Double-click on the 
Masterpieces CD-ROM icon. Double-click on the Acrobat Installer icon. 

3. Read the licensing agreement for Adobe Acrobat and click on Accept. 

4. Follow the on-screen instructions. 

5. When installation is complete, restart your Macintosh. 

MACINTOSH TROUBLESHOOTING 
PROBLEM SOLUTION 

The Infocom Running System 6.0.7 MultiFinder. Change Start-up configuration to start 
Masterpieces up with Finder. 
quits during 
installation 

HOW TO PLAY IN MACINTOSH 

READING MANUALS AND MAPS 
1. Double-click on the Adobe Acrobat folder to open it. 

2. Double-click on the Adobe Acrobat icon to launch it. 
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3. After Acrobat launches, you will be prompted to open a file . Select your 
CD-ROM drive, and select the Docs directOty. Select the INFOCOM.PDF 
file and choose Open. 

4. For help using Adobe Acrobat, select Open from the File menu and open 
the Help-Reader.pdffile. 

Please note: You cannot play the flifocoln Mastelpieces from the Adobe Acrobat 
program. To play the In/ocain Mastelpieces, follow the instructions below. 

PLAYING INFOCOM TEXT ADVENTURES 
1. Double-click on the CD icon on the desktop. Double-click on the folder entitled Mac. 

Select the folder of the game that you wish to play. 

2. Double-click on the icon of the game that you wish to play. 

PLAYING THE WINNERS OF THE 
INTERACTIVE FICTION CONTEST 
1. Double-click on the Masterpieces CD icon on the desktop. Double-click on the 

folder entitled Mac. Select the folder entitled WINNERS and double-click on it. 

2. Double-click on the icon of the game that you wish to play. 

3. For additional help with playing tile winners of the Interactive Fiction Contest, see tile 
README file located on the Masterpieces CD disc. 

Adobe, Acrobat and the Acrobat logo are trademarks of Adobe Systems Incorporated 
which may be registered in certain jurisdictions. 
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CUSTOMER SUPPORT 
Before contacting customer support, please consult tile Infocom Masterpieces README 
file. It contains the answers to some of our most frequently asked questions and may 
qUickly and easily provide a solution to your difficulty. If after reviewing the README file 
you are still experiencing problems, please feel free to contact us til rough any of the 
services listed. 

So that we can better assist you, please be at your computer and have tile following 
infonnation ready: 

1. Complete product title 
2. Exact error message reported (if any) and a brief description of the problem 
3. Your computer's processor type and speed (e.g. 486/66, Power Macintosh 7500/80 ... ) 
4. Video and sound card makes and models (e.g. Diamond Stealth 64 Video, Sound 

Blaster 16 sound ... ) 

CUSTOMER SUPPORT IN THE U.S. 

ONLINE 
Services with Activision Forums, E-Mail and File Libra1J1 Support 

• Microsoft Network: From any MSN window, pull down the Edit menu and select 
Go to then Other Location. At the prompt, type "Activision" and click OK. 

• America Online: Use keyword "Activision" to locate the Activision fomm. 
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ONLINE (CONTD.) 

• CompuServe: 76004,2122 or [GO GAMBPUB] 
• Activision BBS: (310) 479-1335 Up to 28,800 Baud; 

Settings: 8 Bits, No Parity, 1 Stop Bit (8, N, 1) 

Services with E-Mail Support 
• Prodigy: ACTIlOB 
• GEnie: ACTIVISION 

Internet 
support@activision.com or http://www.activision.com 

For infonnation on how to use our listserver, please send e-mail to 
CSbuUetins@listserv.activision.com with the word "help" in the subject line. 
If you 're already familiar with listservers, send e-mail to the same address with the 
word "index" in the subject line of your message for a list of files available from tllis 
service. 

FAX (310) 479-7355, 24 hours a day. 

FAXBACK (310) 473-6453, 24 hours a day 

MAIL 

PHONE 

Activision Customer Support, 
P.O. Box 6m3, Los Angeles, CA 90067 

Call our 24-hour voice-mail system for answers to our most frequently 
asked questions at (310) 479-5644. Or contact a customer support 
representative at the same number between the hours of 9:00 a.ill. and 
5:00 p.m. (Pacific Time) Monday tm·ough Friday, except holidays. 

CUSTOMER SUPPORT IN THE U.K & 
AUSTRALIA 

In the U.K., please call 0990 143 525. 
In Australia, please call 1902 962 000. 

Or contact a customer support representative through the following online services. 

ONLINE 
Services with Activision Forums, E-Mail and File Libral)1 Support 

• Microsoft Network: From any MSN window, pull down tile Edit menu and 
select Go to then Other Location. At the prompt, type "Activision" and 
click OK. 

• CompuServe: 76004,2122 or [GO GAMBPUB] 
• Activision BBS: (310) 479-1335 Up to 28,800 Baud; 

Settings: 8 Bits, No Parity, 1 Stop Bit (8, N, 1) 

Internet 
support@activision.com or http://www.activision.com 

For infOlmation on how to use our listserver, please send e-mail to 
CSbuUetins@listserv.activision.com with the word "help" in tile subject 
line. If you are already familiar witillistservers, send e-mail to the same address 
with the word "index" in the subject line of your message for a list of files 
available from this service. 
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ACTMSION Umlted 9O-Day Warranty 

Activislon warranls 10 the original COOSUITIef purdlase' of Iti5 computer softwara product thai the recording medium on which the software program is recoo:Ied wi] be free from 
defects in material and workmanship fOf 90 days from the date of purchase. If the recording medium is foond defective within 90 days of original poo:hasa, ACTMSlo,'II agrees to 
replace, free of charge. any product cflSCOVellld to be defective within such period upon receipt alits Factory SeMce Center of the product. postage paid, with proof 01 date of purchase, 
as long as the program Is stiI being manufactured by AClMSION. In the event thai the program Is no longer available. ACTMSION retains the rlghllo &JbstiMe a sirriIat product of 
equal Of grealer value. 

This warranty Is Iirmed to the recorcflog meCUTI ccntai1ing the software program orignarty provided by ACTMSION and is oat applicable 10 oormaI wear and lear. This warranty 
sha' not be app6cabIe and shall be void If the defed has arisen throogh abuse. mistreatment, Of neglect. Arty rnp!ied wcvranties appI"lCabIe to this product are imited 10 the 9O-day 

"'""" desaibed al><Ml. 
TotBCeive a replacement, you should enclose theoriginaJ producI.<f:sks only, in protective packaging accompanied by 

• a brief statement desaibing the defect, 

• )'OIK name and relool address. aod 
• a photocopy of your dated sales receipt. 

Please see the special "RETURNS" information for fLr'ther i'tstructions. Any Ql.I8StIons? Cal ACTMSION Customer SUpport al one of the I'IIJ1'lbers shown below. 

EXCEPT AS SET FORTH ABOVE, THIS WARRANlY IS IN UEU Of All OTHER WARRANTlES, WHE'lHER ORAl OR WRITTEN, EXPRESS OR IMPUED, INCLUDING ft.Nf WARFlANTY 
Of MERCHANTASIUTY OR FITNESS FOR A PARTICUlAR PURPOSE, AND NO OTHER REPRESENTAnON OR CLAIMS OF ANY KIND SHALL BE BINDING ON OR OBUGATE 
ACTMSION. IN NO EVENT 'NILL ACTMSION BE LIABLE FOR SPECIAl, INCIDENTAl.. OR CONSEOUENTIAL DAMAGE RESULTING FROM POSSESSION, USE, OR MAlFUNCTION 
OF THIS PRODUCT, INCLUDING DAMAGE TO PROPERTY AND, TO THE EXTENT PERMm ED BY LAW, DAMAGES FOR PERSONAL INJURY. EVEN IF ACTMSION HAS BEEN 
ADVISED OF THE POSS/BtUTY Of" SUCH DAMAGES. SOME STATES 00 NOT AJJ...(JN UMrTATIONS ON HOW LONG AN lMPUED WARRANTY lASTS ANOJOR THE EXCLUSION OR 
UMrTATION OF INCIDENTAL OR CONSEOUENTlAlOAMAGES, SO THE ABOVE LlMlTATIONSANDIOR EXCLUSION OR UMrTATION OF LlABILITY MAY NOT APPLY TO YOU. THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATETO STATE. 

Alter the warranty period. a defective A.ctivIsioo CD Of r.oppy disk may be returned 10 ActivisIon with a check Of money ordef!Of 57 U.S. ~UD$12.00 for Australia, or £7.00 fOf 
Europe) CLm!OC)' per CO or floppy disk IOf replacement (/ruSt be wi'!tWl one year of purchase). 

RETURNS: 
Certified maills recorrmended tor reh.ms. For best service, p!ease be sure tD-

1. Sond1heorig""produc1 ..... onIy.,, __ ..... 
2. Enclose a photocopy of ')'O'J dated sales receipt. 

3. EocIose you- name and relOOl adOO!ss, typed or printed clearly, inside the package. 
4. EocIose a brief note desa'ibi:'Ig the prob!em(s) you haw encounlered with the software with the name of the product and the brand and model name Of model number of yru -. 
In the U.S. send to: 
WARRANTY REPlACEMENTS 
ACTMSlON 
P.O. Box 67713 
""AAgeIes. CA 90067 
USA 
(310) 479·5644 

COPYRIGHT: 

10 Europe send to: 
WARRANlY REPlACEMENTS 
ACTMSION 
Long Island ...... 3A 
1/4 Watple Way 

London, WJ ORO 
UnitedKtngdorn 

Disc Replacement: 01817429400 

'01 Austra!laseod to: 
WARRANTY REPLACEMENTS 
ACTMSION 
P.O. Box 873 
EppIng,NSW2121 

"""""" '''''''_ 1611 2 9869 0955 

llle enclosed software product Is copyrighted and aH rights are reserved by ActivIsion, loc. it Is published exc1usiveIy by Activision, loc. The olStribJtion of IhIs prcduct Is intended fOf the 
use 01 the original pt.rChaser only aod !Of use onty on the computer system specified. Lawful U5efS 01 this program are hereby &censed only 10 read the program from its medium into 
memory of a compt.rter solely tor the purpose of executi'lg the program. Copying (except fOf one backup copy on those systems which provide fOf itl. duplicating, saling, Of otherwise 
cflStributing this product 1s a vioLation of the law. This maouaI and aI other documentation oontained herein are copyrighted and aI rights reserved by ActivIsIon, loc. These documents 
may not, in whole or In pNI, be copied. photocopied, reproduced, translated. Of reduced to any electronic medium Of machine-feadabI form withoot prior consent, in writing. from 
ActiYision, Inc. Wl1ifui violations of the Copyright Law of the United States can result In civil damages of lIP to S5Q,OOO in addition 10 actual damages, plus CI'!rlinaJ penalties of up to one 
year Imprisonment andIOf a 510,(0) me. In addition, violations of the Copyright law of ottlef ;..isdictions may result In eM da.<nages a:1d, in certai1 ci'tuns\.aoces, etimi1aJ penalties. 

o 1996Activision, Inc. 



Before Mailing in the 
Registration Card: 

Be sure to write in the Activision address of your 
region on the front of the registration card. 

P.O. Box 67713 
Los Angeles, CA 90067 
U.S.A. 

Long Island House, 3A 
1/4 Warple Way 
London, W3 ORQ 
United Kingdom 

P.O. Box 873 
Epping, NSW 2121 
Australia 



Before Mailing in the 
Registration Card: 

Be sure to write in the Activision address of your 
region on the front of the registration card. 

P.O. Box 67713 
Los Angeles, CA 90067 
U.S.A. 

Long Island House, 3A 
1/4 Warple Way 
London, W3 ORQ 
United Kingdom 

P.O. Box 873 
Epping, NSW 2121 
Australia 
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MASTERPIECES OF INFOCOM REGISTRATION CARD 
For better serv'ce please take a few moments to fill out this card and return it. 

I I I I I I I I I I I I I I 
Last Name First Name 

I I I I I I I I I I I I I I I 
Street Apt. No. 

L..JI 1L..J1l..-1,--,--,--,--,--,--,--,--,--,--,------,1 I I I I I I I I I I 
City State or Province 

I I I I I I I I I I ITIJITIJ,------,------,,------,------, 
Zip Code Country Phone 

I I I I I I I I I I I I I I I I I I I 
Internet Addre s 

Place of purchase: _ ________________________ _ 

Player's age: ___ 0 M 0 F Purchaser's age: ___ 0 M 0 F 
About your computer: 0 IBM Compatible 0 Macintosh 0 Power Mac D Other _______ _ 

Processor: 0 386 0 486 0 68030 0 68040 0 Pentium 0 Power PC 0 Other Speed: _MHz 

Memory: 0 2 MB 0 4 MB 0 8 MB 0 Over 8 MB Hard Drive Size: MB 

Disc Drive(s): 0 5.25" 0 3.5" 0 CD-ROM drive Graphics: 0 VGA 0 Super VGA 0 Mac Color 0 Mac BIW 

Peripherals: 0 Joystick 0 Mouse Modem Speed: 0 2400 Baud 0 9600 0 14,400 0 28,800 0 Other 

Operating System: 0 DOS 0 Windows 0 Mac D Other ____________ _ _ _ 

Sound Card: 0 Ad Lib 0 Sound Blaster 0 Roland 0 Media Vision 0 Other ________ _ _ 

Preferred Game Type : 0 Action 0 Adventure 0 Role playing 0 Sports 0 Simulation 0 Educat ion 
o Kids Ent. 0 Strategy D Other _ ____________________ _ 

Video game machines in your home: 0 Super Nintendo Entertainment System 0 Sega Genesis 0 Sega CD 
o Sega Saturn 0 Sony Playstation 0 Atari Jaguar 0 3DO 0 Game Boy 0 Game Gear 0 Other ___ _ 

How many computer games do you own? _ ___ _ Game cartridges? _______ _ 

What magazines do you read? _ _ _ _ _ _________________ _ 

Children in household? 0 Yes 0 No Age(s) _ ________________ _ 

Where did you hear about our product? 0 Store shelf 0 Friend 0 Magazine 0 Other _____ _ 

CLASSIC TEXT ADVENTURE 

MASTERPIECES 

OVER 30 INFOCOM® TEXT ADVENTURES 

CDD-3640-221-U3 


